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About NexTalk 4.0 

Product Overview/New Features 
NXi Communications, Inc. has had an Internet powered phone system in operation for over a year for 
many of the organizations using our NTS product.  This system already has many NTS users linked to 
it, including five federal agencies, many state agencies, large corporations and non-profit organizations.  
With the introduction of the NexTalk Freeware and our new NexTalk.net Service, consumers can link 
to this special phone system as well. 

NXi has many different NexTalk products available for use by both businesses and consumers.  
NexTalk for Windows was our first stand-alone product, designed to work with our special NexCom 
300vi modem.  NexTalk for Networks is the client software used by those running our NXi Text 
Services (NTS) product.  NexTalk VM was created with a special TTY emulation method that allows 
users to make TTY calls with standard voice modems rather than special TTY modems. 

With the release of our 4.0 Generation, NXi Communications, Inc. brings together the NTS client 
communications software (NexTalk for Networks) and the consumer software for home/standalone use 
(NexTalk VM), into one code base.  The original BETA version of NexTalk 4.0, which works in 
conjunction with the Beta release of Nextalk.net, will be expanded on in the future to include more 
options and features. 

Our NexTalk products are designed for person-to-person “text telephone” use, providing compatibility 
with the TTYs used by the deaf and hard of hearing.  The latest release includes additional Internet 
functionality that provides compatibility with Internet browsers.  The ability to call TTYs through an 
Internet browser is made possible by the NexTalk.net Service (see www.nextalk.net).  NXi’s servers 
are connected to TTY compatible equipment that subscribers to NexTalk.net can access for their calls.  
See the guidelines for use and pricing information on the website for more details. 

The network version, NexTalk for Networks, allows direct calls to and from any TTY or modem 
through shared network modems that are TTY-compatible.  By connecting NTS sites to NXi 
Communications' Internet-powered Backbone, NexTalk for Networks also supports calls from Internet 
browsers.  With NexTalk for Networks, you can carry on text conversations and exchange messages 
with other NexTalk users on a LAN or WAN (without the use of a modem), and with other users in 
domains linked to the communication backbone.   

The Freeware version of NexTalk 4.0 includes a personal phonebook for storing information about 
other NexTalk.net users and making calls/sending messages to these users.  If you know the special 
domain address (Nextalk address) for users at linked NTS sites, you can also create phonebook entries 
for them.  Future releases, and the NexTalk for Networks version now, will include domain 
phonebooks with entries showing users in linked NTS sites/domains.  NexTalk.net users can place calls 
or send messages from these phonebook entries.   

New to this version, paging support is now done via email.  Most paging services have moved to email 
capable pager/page forwarding methods.  Now text messages left for NexTalk users can be forwarded 
to email capable pagers, cell phones, PDAs, etc.  (Contact your paging service provider to ask if your 
pager can receive email messages.) 

Another new feature in the latest release of NexTalk 4.0 is support for JAWS screen readers for 
enhanced accessibility.  If a person has JAWS installed on their computer, NexTalk 4.0 will 
automatically detect it and will install the support files and scripts needed by the client to navigate with 
JAWS.  There are also a few options in the Conversation Window that can be set to work with JAWS. 
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Getting Started 

Using the NexTalk Toolbar 
If you are reading these instructions, you have either downloaded a copy of NexTalk 4.0 to run on your 
own computer, or you are part of an NTS system and are running the client software.  Many of the 
calling features are also available from the NexTalk.net website as well as from the downloaded 
software.  Whether you are running the software from your computer, or making calls through the 
website, you will need to login with your user name and password.  For nextalk.net consumer users, 
user names and passwords are set up when you first sign up for our service.  For NTS client users, login 
names and passwords are set up by the NTS administrator.  NTS users log in to the main server within 
their organization, which in turn logs in to the Backbone (if that option is chosen). 

Our NexTalk software is ideal for those who make and receive frequent calls, as well as those who will 
use NexTalk only rarely—primarily to receive text messages and return the occasional call.   

In its standard operating mode, NexTalk displays a simple toolbar that provides access to all basic 
NexTalk functions.  The toolbar provides feedback regarding the status of your login to the 
NexTalk.net system as well as whether you have unread messages in your mailbox.  For NTS clients, 
the toolbar will also show whether they have text mail in a department mailbox. 

NexTalk Toolbar Buttons: 

 Dial (accessed via keyboard F3): Call a phone number or NexTalk user 

 Send (accessed via keyboard F4): Send an Instant Message 

 Phone Book (accessed via keyboard F5): Set up entries or make calls 

 Viewer (accessed via keyboard F6): Read saved conversations and new messages 

 Help (accessed via keyboard F1) 

    Mailbox msg. status 

        Dept. msg. Status 

      Login status 

 
 
See also User Preferences (page 21). 
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Calling and Answering Basics 

Carrying on a Text (TTY) Conversation 
The following conventions apply when carrying on a text conversation with someone using a TTY: 

When you finish typing your text you then type GA (for “go ahead”) to let the other party know that it 
is his/her turn to type back.  It is important to wait until the other party has typed GA before beginning 
to type back (unless you are in a split-screen mode).  When you are ready to end your TTY 
conversation you type SK (for “stop keying”).  Sometimes people type GA to SK, which means that 
they are done typing but lets the other person add comments if he/she wishes.   These conventions are 
important because in TTY connections each person must take turns typing rather than being able to 
type at the same time. 

With our NexTalk products, it is possible to use split screen modes when connected at modem speeds 
higher than TTY or when connected via a network or browser.  In split screen, each person is able to 
type at the same time.  This mode is only available if each person is using software that supports a chat 
mode.  All of our NexTalk software products support split-screen chat for non-TTY connections. 

To separate incoming and outgoing text, select a split-screen view mode.  In the Settings menu, 
Preferences, you can also choose font type, size, and color schemes for conversations and instant 
messaging to help track which text is incoming and which is outgoing.  

 

Receiving a Call 
Answering any type of call in NexTalk is simple (incoming calls from TTYs are not yet supported by 
nextalk.net).  When your software is running and logged in to your NTS domain, a Ring box will flash 
on your computer screen to alert you that there is an incoming call. With special X-10 hardware, the 
system can also activate lamp flashers.  If additional information has been attached to the call, the Ring 
box can tell you whether the incoming call is from another NTS user, an Internet caller, or from an 
outside caller/phone number.  If the caller is an NTS user or Nextalk.net user, the Ring box will display 
the caller’s user name. To provide an audible alert, NexTalk can also play a wave file (you must have a 
sound card and speakers), when a new call is received. 

When a call rings to your computer, you choose whether or not to answer the call.  Click the ANSWER 
button to take the call, the TAKE MESSAGE button to route the caller directly to your text mailbox to 
leave a message, or the DON’T ANSWER button to ignore the call.  

To take an incoming call: 

1. Click the ANSWER button on the Ring form. 

2. Your greeting message will automatically be sent to the caller and you can begin your 
text conversation.  (see User Preferences for information on configuring a greeting) 

3. When you have finished your conversation, click on the HANG UP button to hang up 
the call. 

4. A Save Conversation dialog box will appear.  To save the conversation, give it a 
descriptive name (or accept the default), select a Conversations category/folder from 
the list box and click SAVE.  To delete the conversation click DON’T SAVE.  You 
will learn how to create your own conversation categories/folders in the Viewing 
Saved Conversations section. 
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_________________ 

See also 

Viewing Saved Conversations  

Making a Call 
With NexTalk you can make calls directly to any TTY or modem user or to another NTS user.  Outside 
(modem) calls are made by accessing a shared TTY compatible modem hosted by NXi 
Communications or, (for networked users), hosted by the network that is running your NTS domain.  
For NTS sites, you can make calls within the network to other NexTalk for Networks users without 
using a modem.  Users must be logged in to NTS in order to make and receive network calls.  You can 
make calls from the NexTalk Phone Books or call directly using Quick Call (the DIAL button).  

 Currently, Nextalk.net users can only call each other or other NTS users through the Service.  In the 
future, if the user is subscribed to a plan that includes TTY call minutes, Nextalk.net users can call 
through the TTY modems housed by NXi.  You must be logged into the Service and have access to 
calling minutes in order to make calls to a phone number. 

If your NTS site is linked to NXi’s Communication Backbone, you can make calls from your phone 
book to other NTS users in organizations that are also linked to the Backbone (other NTS domains).  
Those users must also be logged in and must be assigned to departments that have been made “public,” 
rather than “private” departments.  If the remote domain is not linked to the Backbone, users may still 
show up in the phone book but calls made to them will not be completed. 

 

To make a quick call using the DIAL button: 

1. Click the DIAL button on the toolbar to bring up the Make a Call box. (Function key F3) 

2. Type in a Phone Number or a Name, and click OK.  You must know the exact username of 
a NexTalk.net or NTS user in order to call them via name.  For example, the user “Joe” in 
an NTS domain named “test” would be dialed by typing joe@test.  A Nextalk.net user 
would be dialed as joe@nextalk. 

3. When calling a user in another NTS domain, we recommend dialing through the Phone 
Book rather than using a Quick Call.  However, if you know the exact domain address of 
the user, you can type that in the Dial box.  Users within your own domain can be dialed 
by typing just their username without the @xxxx. 

You can also make calls through the Personal Phonebook entries you have created (see topic). 
_________________ 

See also 

Phone Books  
Viewing Saved Conversations  
Conversation Window Settings  
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Messages and Conversations 

The Conversation Window 
There are several options that can be chosen and configured during an active conversation.  The top of 
the window will show you information about who placed the call.  If the call is from another person in 
your organization or from a Nextalk.net user, their full name will automatically appear in the top line.  
If the call is from a browser user, then whatever name they typed in the response box (if used) will 
appear.  If the call is coming in through a telephony server (modem, telephony card, etc.), then it will 
most likely display the name of the server, or the phone number of the server/modem that is handling 
the call.  In future versions, additional information can be added to automatically identify the caller. 

 

Some of the conversation window buttons are: 
Hang up:  Use this button to end your call (from the File menu, you can also pick Hang Up or 

Ctrl +H) 

Transfer:  Use this button to send your call to another NexTalk user.  They must be a user 
within your domain or linked through NXi’s Communication Backbone.  (from the File 
menu, you can also pick Transfer Call or Ctrl +T) 

Conference:  This button will be grayed out unless you have more than one active 
conversation in progress.  Use this button to create a conference call between linked 



10       NexTalk 4.0 

users, browser callers, or other users within your domain. (from the File menu, you can 
also pick Conference or Ctrl +F) 

Full Screen:  See View Modes (page 15) for more information.  This is the default view for 
TTY conversations.  We recommend this view for screen readers as well.  Use this button 
to select this view in the middle of a call. 

Vertical:  See View Modes (page 15) for more information.  When you are connected to other 
NexTalk users, this mode will automatically be launched.  You can select this mode at 
any time as long as you are not connected via TTY.  Use this button to select this view at 
any time during a call.  It will be grayed out if it is not an available option. 

VerticalE:  See View Modes (page 15) for more information.  This mode is used with browser 
callers and will show you a view of the web page from which they called.  Use this mode 
when pushing web content to browser callers.  Use this button to select this view at any 
time during a call.  It will be grayed out if it is not an available option. 

Horizontal:  See View Modes (page 15) for more information.  You can select this mode at 
any time as long as you are not connected via TTY.  Use this button to select this view at 
any time during a call.  It will be grayed out if it is not an available option. 

Print:  At any time during a call, you can send the conversation text to your printer by 
pressing this button. (from the File menu, you can also pick Print or Ctrl +P) 

 

Unscramble TTY Text (Edit menu, Ctrl +U):  
This option will be available during a TTY call.  Switched case is a common occurrence during 
TTY calls.  A TTY device may miss the character that indicates a change from numbers to letters 
case or vice versa.  It will continue to send the numbers case when letters should be sent, or will 
send letters when numbers should be sent.  You can manually switch the case in NexTalk using the 
TAB key.  However, any text that was sent before you switched case can be fixed as well.  Simply 
highlight the scrambled text and then select the Unscramble option from the Edit menu.  

View Menu: 
The options in this menu include ways to modify and interact with text during conversations.  You 
can choose to have the screen Show Erased Characters, set a preference that will bring the 
conversation window on top of any other application open on your desktop, or set the window to 
display all Call Tokens included in the call.  A Call Token carries important information for 
routing messages within the system, such as source and destination addresses, system scripts, call 
type, etc.  This menu also has an option for showing a Conversation Bar, which is used by JAWS 
for it's text to speech accessibility features.  JAWS is a screen reader used by some to navigate 
through Windows programs.  This feature is currently support for NTS clients only, not 
NexTalk.net users.  

Alerts Menu: 
There may be times when you need to turn your attention away from a conversation to answer a 
question, or take another call.  There may also be times when the other caller is typing a very 
lengthy reply or a long block of information is transmitting very slowly onto your screen or when 
they have asked you to hold.  In these cases, you may want to set up special Alerts to let you know 
when it is time to again pay attention to the conversation window.  If you have minimized the 
window to work on a second conversation, or another program, you can enable an option that will 
bring the conversation window back to the foreground when the alert is triggered. 

NexTalk provides an “Alert Stopped Typing” option (F10) that will flash on your screen, and can 
play a sound, whenever the window has stopped receiving text (about a 3 second pause).  You can 
pick your own .wav file for this alert or accept the system default sound.  (The .wav file and 
foreground option is selected in the Settings | Preferences | Conversation Alerts menu of the 
Toolbar.)   
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NexTalk also provides an “Alert Started Typing” option (Ctrl +F10) that will flash, and can play a 
sound, whenever the window starts receiving text after a pause.  If the caller asks you to please 
hold, you can enable this alert and it will notify you as soon as they start typing again.  You can 
pick your own .wav file for this alert or accept the system default sound.  (The .wav file and 
foreground option is selected in the Settings | Preferences | Conversation Alerts menu of the 
Toolbar.) 

Text Menu: 
It is possible to log in to the client software as a department.  You must know the department 
password in order to do this, thus providing some administrative controls.  When logged in as a 
department, it is possible to create pre-composed text, much as you would as a user, which is made 
available to all members of the department.  This is a valuable tool for sales purposes, technical 
support, etc.  Any text that is commonly used within a department by all its members can be 
typed/configured once, and then used by all department members during calls.  Each department to 
which you belong will appear in the Text Menu.  Those departments that have pre-composed text 
set up will list the description of each text block when their name is highlighted.   By selecting the 
description or using the hot key combination from the Text Menu, you can transmit department 
text during a call.  Your own precomposed text block descriptions will be displayed in the lower 
half of this menu.  (See Settings | Preferences | Precomposed Text ) 

 

 

Accessibility Menu: 
This menu has two options that are designed to work with JAWS screen readers for NTS' NexTalk 
client software (not yet supported in NexTalk.net).  You can set JAWS' voice cues to Speak Faster 
or Speak Slower from this menu. 

 

 

Retrieving Saved Messages 
Every NexTalk.net and NexTalk for Networks user has a text mailbox.  TTY and modem callers, as 
well as other NTS users or Internet browser callers, can leave text messages for a user in this mailbox. 
(NexTalk.net users: Please note that in order to receive calls from TTY/modem callers, you must have 
a phone number assigned by NXi.  This is not available during the BETA period.)    
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Mailbox messages can be read using the NexTalk Viewer and, if desired, can be forwarded to e-mail to 
be read via your own email program.  Message routing to e-mail accounts means that email capable 
pagers, email capable cell phones, or email capable PDA devices can also receive messages.  

When a new mailbox message has been received, the MAIL status box on the NexTalk toolbar will 
change color (blue indicates an unread message(s) in the Inbox).  Department mail can also be read by 
NTS users who have been assigned to a department.  The DEPT box on the NexTalk toolbar will show 
blue when a message is in the department’s text inbox. 

To view your mailbox messages: 

1. Click on the VIEWER button on the toolbar (Function key F6). 

2. Click on the Inbox folder and highlight each message one by one to read it.  Personal 
messages are stored under your name in the Inbox—Text Mail, Conversations are stored in the 
Inbox—Conversations folder.  You may need to click the “+” sign to expand the view to see 
these folders.  Department messages are stored in the Inbox—Text Mail folder under each 
department name.   

3. You can delete, print, or move your messages to another category as you view them, or copy 
the message to the Windows Clipboard.  You can also click and drag to move messages from 
one folder/category to another.  As long as a message is in the Inbox—Text Mail folder, the 
MAIL and/or DEPT letters on the toolbar will remain blue, even if you have read it.  You 
must move or delete the message to clear this indicator. 

To create a new Inbox message category: 

1. Select the Inbox—Text Mail or Inbox—Conversations folder. 

2. Select File | New Folder from the menu. 

3. Type in the new folder/category name in the text box and click OK. 

To move a mailbox message from one category to another: 

1. Highlight the message in the main list box. 

2. Click on the File | Move Items to Folder option.   

3. Select the new folder/category from the list box and click OK. 

4.    You can also click on the message and drag it to the desired folder using your mouse. 

To copy messages outside the NexTalk mailbox (for use with other applications), highlight the portion 
of each message you want to copy, go to the Edit menu and choose the Copy to Clipboard option.  To 
copy the entire message, pick the Select All option from the Edit menu.  You can now paste the text 
into another application such as Windows Notepad. 

_________________ 

See also 

Sending Messages  
User Preferences  

Viewing Saved Conversations 
Your NexTalk conversations can be easily saved and stored for future reference.  When you hang up a call, a 
dialog box appears where you can give the conversation a brief description and save it to a category for easy 
reference.  NexTalk allows you to create your own unique categories for storing conversations and messages.   
Once a conversation has been saved, it can be accessed through the NexTalk Viewer.  Saved conversations can 
be printed, deleted, or moved to a different category, much the same way that mailbox messages can. 
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To view a saved conversation: 

1. Click on the VIEWER button on the toolbar (Function Key F6). 

2. Open the Inbox—Conversations folder in the left hand list box (you may need to click on the 
“+” sign next to your name to expand the list). 

3. Highlight the desired conversation in the top right list box to view it in the lower text box.  
The top and bottom list boxes can be resized to allow more or less viewing area.  
Conversations will be displayed in the view mode in which they were conducted.  To display 
the conversation in a different view mode, click on either the Full Screen , Vertical, or 
Horizontal mode buttons.  If a view mode button is grayed out, it is not available for that 
conversation. 

4. To print the conversation, highlight it and click the PRINT button. 

Follow the same procedures to move, delete, or create new Conversation categories as you do for Text 
Messages.  You can also drag and drop conversations from one folder to another using your mouse.  To copy 
conversations outside the NexTalk mailbox (for use with other applications), highlight the portion of each saved 
conversation you want to copy, go to the Edit menu and choose the Copy to Clipboard option.  To copy the 
entire message, pick the Select All option from the Edit menu.  You can now paste the text into another 
application such as Windows Notepad. 

 

_________________ 

See also 

Conversation Window Settings 
Retrieving & Routing Messages 
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Sending Messages 
With NexTalk you can easily send text messages to any user/department on your own NTS system.  If 
you are linked to NXi’s Communication Backbone, you can send messages to NexTalk.net Service 
users or you can also send text messages to a user in a linked NTS domain.  Messages can be sent 
directly, with the SEND button on the NexTalk toolbar, or from the NexTalk Phone Books.  One 
interesting new feature of NTS 4.0 is that messages in your Inbox—Text Messages can be replied to 
directly from the viewer.  

 

 

To send a message directly to a user’s computer screen: 

1. Click on the SEND button on the toolbar (Function key F4) or highlight the user in your 
Phone Book (Function key F5) and click SEND.  

2. A Send Message box will appear.  Either type the person’s username in the To: box, or click 
the Phone Book button and select him/her from your phonebook entries.  If you are sending to 
another NTS or NexTalk.net user, select the NTS Address option.  If you are sending to an 
email address, select the Email Address option (email messages can't go out as Instant 
Messages, only as Mail) and type in the email address.  Type your message, and click Send (or 
CANCEL if you don’t want to send).  To select the method by which the message will be sent, 
click the circle next to the desired option.  “Send via” options include Text Mail (for a 
NexTalk user's Inbox—Text Mail) or Instant Message (to pop directly to his/her screen). 

3. For Instant Messages, if the NTS user is currently logged in or a NexTalk.net subscriber is 
connected to the Service, they will immediately see your message on their computer screen.  
The recipient can reply to your message, or close without replying.   

4. If the user is not currently logged in, a message will pop up saying "unable to send" and will 
ask if you want to send it to the user's Text Mailbox instead.  If you click YES, the message 
will be saved in his/her text mailbox, which can then be forwarded to an email address if 
he/she has selected that option.   

When a text message is in the "Inbox—Text Messages," you can highlight that message and then click 
the REPLY button to send a message back to the NTS or Nextalk.net user who originally sent it to you.   
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_________________ 

See also 

Retrieving & Routing Messages  
Phone Books  
 

Conversation View Modes 
NexTalk allows you to select from three different conversation view modes—Full Screen, Vertical 
Split-screen, or Horizontal Split-screen.  You can select a new view mode at any time during a 
conversation by clicking on one of the view mode buttons (except for TTY calls that can only be 
viewed in Full Screen mode).  With automatic recognition of NexTalk callers, the view mode may 
automatically change to split-screen when you connect to another NexTalk user.  Conversations 
will be saved in the view in which they were conducted.  You can also change the view mode of a 
saved conversation in the Viewer. If a view mode button is grayed out, that view is not available 
for that conversation.  

The default view mode for TTY connection speeds is Full-screen (Terminal).  Split screen is not 
available for TTY calls.  In Full Screen mode, incoming and outgoing text is displayed on 
alternating lines.  If a call automatically goes into split-screen mode, you can manually change it to 
Full Screen if you prefer. 

Vertical or Horizontal Split-screen is available for Internet, Network, and 300 baud or higher 
ASCII modem connections, as long as the other party’s software also supports this mode.  For 
Vertical mode, the screen is divided in half vertically - incoming text is displayed in the right 
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window and outgoing text in the left.  For Horizontal mode, the screen is divided top and bottom 
with your text in the top window and the other person’s text in the bottom window.  The benefit of 
Split-screen modes is that each person can type at the same time.  This allows a more natural 
conversation flow, where one person can comment on remarks or break in if needed without 
interrupting the other person. 
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Special Calling Features 

Phone Books 
You can use your NexTalk Phone Book to store frequently called numbers and contact information, 
make text calls, and send instant messages.  In addition to a personal phonebook, NexTalk for NTS 
users provides a built-in phone book of linked and shared NTS sites, public departments and their users 
for Network/Internet calls.  Built-in department phonebook entries are read-only—you cannot make 
changes to entries in the network phonebooks.  If your organization is linked to NXi's Communication 
Backbone, then you will be able to view public network phone books from other linked NTS domains.   

NexTalk provides a Personal Phonebook for user-defined personal calls.  You can add entries to this 
phonebook and edit your entries.  To help you sort your contacts in meaningful ways, you can also 
create subfolders with unique names that you choose (for example, a TTY Friends folder and a 
NexTalk Users folder to sort calls made via TTY versus calls made via the Internet). 

To create a new personal phone book entry: 

1. Click on the PHONE BOOK button on the toolbar (Function key F5). 

2. Highlight the Personal Phonebook folder in the left column and click on the ADD button or 
select New Entry from the Phonebook menu.  If you want to put the new entry in a subfolder, 
highlight the subfolder first (you may need to click the “+” sign next to Personal Phonebook 
to expand the list). 

3. Type the requested information into the text boxes and click OK. 

 

 

Note: 

Dial Scripts are not currently 
supported in NexTalk.  This 
will be released in future 
versions, to add support for 
special dialing features when 
making calls.   

 

 

 

 

 

 

 

The NexTalk Address box on this form can be used to link personal phone book entries to a person’s 
NexTalk.net or NTS User Name.  For NexTalk.net users, this address is a person’s username @nextalk.  
This name is assigned by NXi to each person who signs up for an account, to uniquely identify him/her 
on the NexTalk.net Service.  NTS users' Nextalk usernames are assigned by the company’s NTS 
Administrator.  NTS domain names are assigned by NXi to all sites linked to the Communication 
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Backbone.  You do not create the NexTalk Address for linked users, but if you know this address, you 
can assign it to entries you create.  

Please note that while entries will appear in the folder in the order in which they were entered, you can 
sort them alphabetically by clicking on the LastName, FirstName label in the right hand view window.  
Each time you add a new entry, you will need to re-sort the entries. 

To create a new Personal Phonebook subfolder: 

You can add your own groupings/folders to your Personal Phonebook.  To add a new category, select 
New Department from the Phonebook menu and type in a folder name.  For example, a “NexTalk 
Users” folder could be created for those calls dialed directly to other NexTalk.net users.  Click OK to 
save the new folder. 

To make a call from the Phonebook: 

1. Click on the PHONE BOOK button on the toolbar (Function key F5). 

2. Click on the personal phonebook folder containing the entry for the person you wish to call. 

3. Click on the person’s name in the top right list box and click the DIAL button (or from the 
File menu, select Make a Call).  Select the address/phone# to call and click OK. 

4. You can also click the active links in the bottom right text box for TTY number (to dial using 
a modem), or Email address (to send a text message) or NexTalk Address (to dial an Internet 
call or send a message), if you know the person’s NexTalk Address and have entered it in 
their record. 

 

 
 

The Find option is not currently available but will be added to future versions.  Version 3.x phonebook entries are not 
currently compatible and cannot be imported into version 4.0.  An import utility will be available in the future. 

 

To send an Instant Message: 

1. Click on the PHONEBOOK button on the toolbar (F5). 
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2. Click on the personal phonebook folder containing the entry for the person you wish to call.  
You can only send Instant Messages over the Internet to users who have been linked to 
NXi’s NexTalk.net Service, to other NTS users in your own domain, or to NTS users in a 
linked domain. 

3. Highlight the entry for the user in the top right text box and click on the SEND button (or 
select Send a Message from the File menu).  (You must DIAL anyone who is not linked to 
NexTalk.net via their TTY number and a modem, if you have been given access to TTY call 
minutes). 

4. Type your Instant Message in the Note box, and click SEND.  Subscribed home users must 
be logged on to NexTalk.net in order to receive your message.  Your message will go to 
his/her text mailbox if the user is not logged in when you try to send the Instant Message. 

TIP: The DIAL button is used for real-time conversations/chats, while the SEND button is used for Instant 
Messaging. 

Conference Calls 
NexTalk 4.0 supports conference calls between other 4.0 users, browser callers, and Nextalk.net users.  
This allows you to bring another NTS user and/or NexTalk.net user into a conversation.  With the 
NexTalk.net service and NTS domain linking through the NXi Communication Backbone, conference 
calls can include users outside your own NTS domain (providing their domain is also using 4.0) as well 
as Internet browser callers and other NexTalk.net users.  A conversation might include participants 
from several different organizations as well as callers using a web browser, all on a single conference 
call.   The call is held in NXi’s patented Split-screen format so each person can comment on the text of 
another caller and everyone sees each other’s comments in vertical columns. 

To create a conference call: 

1. During an active NexTalk conversation, make a new call to the Linked user you wish to add 
to the conversation using either the Phone Books or the DIAL button. 

2. When the new call is established NexTalk will open a second Conversation Window. 

3. To add the new party to your existing conversation, click on the CONFERENCE button and 
select the person’s name from the list of all open conversations.  If this button is grayed out, 
then your second conversation is not compatible with conferencing.  TTY callers and TTY 
machines are not capable of participating in conference calls (their devices can't handle the 
format). 

TIP:  One party can leave a conference call by clicking on the HANG UP button without disconnecting the other 
parties. 

 

_________________ 

See also 

Making A Call  
 

Call Transfers 
With NexTalk 4.0 you can transfer a call to a Linked NTS user or department or to another 
NexTalk.net user during an active connection. If a caller has been routed to the wrong person, or if you 
want a caller to speak with someone else in your organization, you can easily transfer that caller to the 
appropriate person.  This can also be useful for NexTalk.net users.  For example, if Jane knows the 
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username of Bob, but doesn’t know the username of Bob’s wife, Jane could call Bob and ask him to 
transfer the call to his wife.  Bob knows her username and can pass the call along to her. 

For NTS' NexTalk Users:  In linked NTS domains any NTS user or browser caller can be transferred to 
other linked users or departments in a different NTS domain.  For example, the main office of a bank 
could transfer a TTY or browser caller to the specific branch in his/her city or vice versa.  This type of 
call transfer is only available to users/organizations who participate in NXi’s Communication 
Backbone, and can only be made to other Linked domains. 

To transfer a call: 

1. During an active call, click on the TRANSFER button in the Conversation Window. 

2. Select a NexTalk.net user from your phonebook, or type an NTS user or department address 
in the box.  To transfer a call to a linked NTS domain, you must know the full name of the 
domain and user or dept. in the domain (for example tech@nxi). 

3. Click on the TRANSFER button to activate a ring alert to the new user (for a live 
conversation). 

4. To route the caller directly to a text mailbox to leave a message, click on the MAILBOX 
button instead. 

 

Multiple Conversations 
 

NexTalk gives you the ability to carry on more than one conversation at a time on your computer 
screen.  This feature is especially useful for NTS users who answer and route calls and for those who 
make or receive a high volume of computer-based calls.  You must be able to hold multiple 
conversations in order to conference them together into one call. 

Multiple conversations that involve TTY callers and a modem are limited by the number of modems 
available to take calls.  A TTY compatible modem can only handle one call at a time per port and 
phone line.  Note that TTY callers cannot participate in conference calls. 

_________________ 

See also 

Conversation Window Settings  
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Configuring User Settings 

Login Procedures 
Each NexTalk 4.0 user must be logged in to either their NXi Text Services (NTS) domain or their 
NexTalk.net account in order to make and receive calls (in BETA, Nextalk.net users cannot receive 
calls) and read messages.  It is not necessary to log in to the service if you are calling via the 
NexTalk.net website to another NexTalk user, but is necessary when running the software on your own 
computer or when making TTY calls from the website.   

For NexTalk.net users: Login names (user name--also the NexTalk Address) are selected when you first 
create your NexTalk.net account.  You need to remember the user name and password that you select 
when you set up your account because you will be asked for them each time you start the program. 

 

For NTS domains/networked users—to enter/view NTS login information: 

1. When you first start the software you will be asked to enter (or just confirm prior entry of) 
your Username and Password in the Login screen. 

2. Type in your NTS Login Name (login names are created by your NTS system administrator 
in the NTS Administration utility). 

3. Enter your Password (passwords are created by your NTS administrator).  If you want 
NexTalk to remember your password the next time you login, select the checkbox. 

4. Type in a valid IP Address and Port Number for the NTS Resource Manager (now called 
the CP) to which you are connecting (contact your NTS administrator if you do not know 
this information).  System defaults should already be in these boxes. 

5. Click OK to save your login settings.  (Click CANCEL to exit without saving any changes.) 

These settings will remain in effect each time you open NexTalk for Networks until you or your 
NTS Administrator make changes.  

Command Line Parameters: 

It is possible to select special startup settings for each person running NexTalk using command line 
parameters.  These options will be in place each time you start NexTalk from either the Windows 
Start!Run command line, or from a shortcut on the desktop whose "Target" line has been modified 
with the parameters. 

Available command line parameters include:  IP address of the NTS CP (-cp=), port number (-port=) 
used by NTS (usually 2571), login name (-login=), password (-pwd=), and taskbar (-taskbar=) which 
starts the program minimized to the taskbar. 

An example of a command line that includes all these parameters would look like:  c:\program 
files\nts\nextalk4.exe -cp=65.6.6.650 -port=2571 -login=john -pwd=password -taskbar=yes 

 

User Preferences (F8) 
NTS allows users to set personal preferences, including Password, Greetings, Message Forwarding 
options and Ring Alert, Font/Screen Colors, Pre-composed Text and Conversation Alerts.  These 
Preferences (Function key F8) are configured under the Settings menu. 
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General Information: 

The General Information category on the Preferences form displays your User Name and password 
(passwords are initially created when you sign up for your account or by your NTS Administrator) 
as well as e-mail and pager addresses for message forwarding and your TTY number. While you 
can enter a Voice and Fax number on this form, forwarding via Fax or calling via Voice is not 
currently supported in version 4.0.  These fields are for information purposes only.  If you do not 
enter an email address, message forwarding to email will not work. 

To change your password: 

1. Select Settings | Preferences (F8) from the toolbar. 

2. Highlight General Information from the category list and then click on the CHANGE button. 

3. Type in your Old Password (the password originally selected when you set up your account), 
then type in a New Password (and confirm it), and click OK. 

4. You are not permitted to change your username or full name in the client software.  These 
changes can only be made by the NTS System Administrator. 

If you forget your Nextalk.net password, NXi can send it to you, but for security purposes will only 
send password information directly to the email address assigned to your account.  

Startup & Shutdown Settings: 

The Startup and Shutdown Settings category controls how the NexTalk Toolbar behaves whenever 
you start your computer and/or shut the NexTalk program.  NexTalk can be configured to 
automatically run as soon as you start your computer and run Windows.  It can also be configured 
to minimize to the Windows taskbar tray when you "exit" the toolbar.  This allows you to continue 
receiving calls, but hides the Toolbar from view.  You can always restore the Toolbar by right-
clicking on NexTalk's telephone icon on the taskbar and selecting "Show."  This minimized option 
is considered NexTalk's icon-only view. 

For NTS users, these preferences are logged in the database for your user account and can come 
into play even if you log in to different computers.  However, on each new computer that you use 
to log into NexTalk, your initial login and startup of the software will not use these preferences 
until the new computer has "registered" your use of it for NexTalk 4.0. 

A minimized toolbar can also be configured using command line parameters as discussed in the 
previous Login Procedures section. 

Answering Machine: 

The Answering Machine category contains your mailbox greeting and information about your text 
message forwarding options.  In addition to your Nextalk text mailbox, messages can also be sent 
to an E-mail address (making them accessible to email capable devices) and to a pager.  NexTalk 
creates a default greeting for your text mailbox, which you can change if desired.  You can also 
change the number of rings that NexTalk will wait before sending a caller to your Answering 
Machine. 

To choose Message Forwarding options: 

1. Select Settings | Preferences (F8) from the toolbar. 

2. Highlight the Answering Machine category. 

3. For each forwarding option you wish to use, select the checkbox.  Make sure you have entered 
the corresponding email address and pager email in the General Information category. 

4.    Set the number of rings (must be at least 2), NexTalk will wait before taking a message. 



Configuring User Settings       23 

 

Answer Greeting: 

NexTalk automatically sends an answer greeting when you manually answer a call.  This is a 
different greeting than the one sent when your answering machine takes the call.  Although 
NexTalk creates its own default greeting message(s), you can change the greeting(s) to suit your 
own needs. 

To edit your personal greeting: 

1. Select Settings | Preferences (F8) from the toolbar. 

2. Select the Answer Greeting category. 

3. Edit your greeting in the appropriate text box and click OK. (We recommend putting a “GA” 
at the end of the automatic greeting to let your caller know to respond.) 

Ring Alert: 

The Ring Alert category gives you the option of selecting an audible alert for incoming calls.  
NexTalk automatically sends an on screen notification (ring box) each time you get a call.  When 
you enable this option, NexTalk will either make generic sounds, or play a .wav file you have 
selected, over your computer’s speakers when you have an incoming call. You need to have sound 
card support and speakers in order to hear the .wav file.  NexTalk can still make generic sounds 
over your computer’s speaker if no .wav file is selected (the Wave File box must be empty, but the 
option must be enabled).  In the future this .wav file will be able to activate a lamp flasher as well, 
but for now the alert is tied to the computer monitor/speakers. 

To turn the audible alert on: 

1. Select Settings | Preferences (F8) from the toolbar. 

2. Highlight the Ring Alert category. 

3. Select the checkbox next to “play sound when ringing.” 

4.    If you want to use a .wav file, select the Browse button and choose the path and file name of 
the .wav file. 

Nextalk includes a couple of different wave files for your convenience.  The default path for these 
is C:\program files\NTS 

Conversation Font/Colors:  

Nextalk’s default color scheme and font type/size is black letters on a white background, MS Sans 
Serif 12 point.  You can select your own color scheme to have different colored text and a colored 
background.  You can also decrease/increase the font size and pick a different font style for your 
conversation window.  These settings do not control the way the text appears when printed.  You 
should set your own preferred printer font style/size as well on this form. 

To select the style of font and the font size for your conversation window:  

1. Select Settings | Preferences (F8) from the toolbar. 

2. Highlight the Conversation Font/Colors category. 

3. Select the font from the drop down menu and select (or type) the size.  Select the Conversation 
Printing Font style and size from its drop down menu. 

4. If you want to use the NXi Color Scheme select it from the drop down menu.  Click OK when 
done. 

5. For custom colors, choose the Custom Color Scheme from the drop down menu and then click 
the Change buttons next to each Pane to bring up a color palette. 

Instant Message Font/Colors:  
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The look of Instant Messages that pop onto your screen can be customized by choosing the Instant 
Message Font, the Tag Line font size, the Most recent message size, and Other messages lines font 
size.  You can use the default System Colors of a white background and blue and black text, or set 
your own background color and text colors. 

To customize your color scheme: 

1. Select Settings | Preferences (F8) from the toolbar. 

2. Highlight the Instant Message Font/Colors category. 

3. Select your desired font style and the font sizes for each type of text line.  Your changes will 
be displayed in the sample window. 

4. To change font and screen colors, uncheck the “Use System Colors” option and then click 
each Change button to select different options.  Your changes will appear in the sample 
message window.  Click OK when finished. 

Conversation Alerts:  

To customize Conversation Alerts: 

1. Select Settings | Preferences (F8) from the toolbar. 

2. Highlight the Conversation Alerts category. 

3. To choose different .wav files for your alerts, click the Browse button next to each type of 
alert.  NXi includes a few sample .wav files in the c:\program files\NTS folder. 

4. To prevent the conversation window from moving to the foreground, uncheck that option. 

There may be times when you need to turn your attention away from a conversation to answer a 
question, or take another call.  There may also be times when the other caller is typing a very 
lengthy block or a long block of information is transmitting very slowly onto your screen or when 
they have asked you to hold.  In these cases, you may want to set up special Alerts to let you know 
when it is time to again pay attention to the conversation window.  If you have minimized the 
window to work on a second conversation, or another program, you can enable an option that will 
bring the conversation window back to the foreground when the alert is triggered. 

NexTalk provides an “Alert Stopped Typing” option that will flash on your screen and can play a 
sound whenever the window has stopped receiving text (about a 3 second pause).  You can pick 
your own .wav file for this alert or accept the system default sound.  The alert itself is enabled 
within an active conversation window in the Alerts menu.   

NexTalk also provides an “Alert Started Typing” option that will flash and can play a sound 
whenever the window starts receiving text after a pause.  If the caller asks you to please hold, you 
can enable this alert, and it will notify you as soon as they start typing again.  You can pick your 
own .wav file for this alert or accept the system default sound.  The alert itself is enabled within an 
active conversation window in the Alerts menu.  

_________________ 

  (See Also: Conversation Window Settings)   
 

Precomposed Text:  

NexTalk’s Precomposed Text ™ feature allows you to easily send and resend commonly used text 
during a conversation.  By adding your own special “hot key” combinations, you can quickly 
access and send pre-written text characters, blocks, etc.  This time saving technique can be used for 
things like the letters “GA,” the letters “SK,” and other text that you commonly use in every 
conversation.  To make this as flexible as possible, any key except for the Function Keys used by 
our program can be turned into a “hot key.”  You should be careful not to pick single letters as hot 
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keys because every time you use those letters, your pre-composed text will be sent instead of the 
letter.  We recommend using the CTRL, ALT, or SHIFT keys in combination with numbers and 
letters to set up your Hot Keys. 

To create Pre-composed Text: 

1. Select Settings | Preferences (F8) from the toolbar. 

2. Highlight the Precomposed Text category. 

3. Click the New Message button. 

4. Give the message a description, type the text you want assigned to the key(s), and then 
click the Assign Hot Key button.  

5. Press your key combination in the order it will be used or click CANCEL.  The Hot Key 
combination you picked should appear in the Hot Key box.  Click OK. 

The list of your pre-composed text options will appear in the window with the description and hot 
keys used for each.  You can choose to edit each option or delete them if they are no longer used.  
You can review and select your Precomposed Text in the Text menu of an active conversation. 

Relay Operator: 

This option was added to support NexTalk.net users and is not currently supported for NTS' 
NexTalk users. 

Incoming and Outgoing Modem Settings 
For networked users:  An NTS system controls a certain number of modems/telephony cards (what we 
call ports).  These ports can be designated by your NTS System Administrator as either “network" or 
“personal.”  This shared equipment is used by the NTS site to make and receive calls. 

NexTalk.net users make their TTY calls by accessing modems housed at NXi Communications, Inc.  
Users must be logged in to the service to gain access to these modems.  During the BETA period, all 
NexTalk.net users have permission to use these modems for TTY calls within the United States and 
Canada of up to 2 minutes in length.  After the BETA period, permission to use modems will be 
assigned based on the type of monthly plan selected by the user.  Each plan will include a certain 
number of TTY calling minutes per month.  Once those minutes are used up, further calls will either be 
denied, or the user may be charged a per-minute fee for additional minutes.  NXi is evaluating usage 
during the BETA period to see how often users are making TTY calls versus Internet calls.  When the 
option to receive TTY calls through NXi’s server is made available, Nextalk.net users must  log in to 
receive live calls. 
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Contacting Support 

Technical Support 
NXi Communications, Inc. provides technical support through our WWW home page 
(www.nextalk.com) and by telephone.  NXi’s Tech Support department hours are Monday through 
Friday from 8 a.m. to 5 p.m. Mountain Standard Time.  Email is monitored during weekdays on a 
regular basis and will be answered as quickly as possible depending on the volume of tech. support 
requests. 

During the BETA period for NexTalk 4.0, technical support requests should be made via Email only 
(send email requests to tech@nextalk.com).  Because the product is a BETA release, tech. support will 
be quite limited.  Users can report bugs or problems they may encounter with the product via a Bug 
Reporting form on our website. 

Normal support options after the BETA period will vary depending on the type of User Account you 
have.  

NTS Support Options are available through your System Administrator.  Most problems/questions with 
the system can be solved internally by the Administrator.  He/She can refer problems outside his/her 
experience to our technical support department.   
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License 

Program/Programs License Agreement 
NexTalk.net Users: 

INTRODUCTION/ACCEPTANCE OF TERMS: NXi offers you (the “user” or “Customer”) an account for the 
NexTalk.net Service (the “Service”) on the following terms (the “Agreement”).  Use of the NexTalk software (the 
“Programs) is controlled by this agreement. 
By using the Service in any way you are agreeing to comply with these terms, which we may update without notice. 
We encourage you to check here for changes at any time. You must be at least 18 years old and competent to enter 
into a contract to use the Service. Unless we expressly note otherwise, these terms incorporate and supersede any 
other terms associated with the files and applications associated with the Service operated by NXi Communications, 
Inc. (”NXi“, ”we“, or ”us“). 
OWNERSHIP/COPYRIGHT OF PROGRAMS: Programs are the proprietary products of NXi and are protected by 
copyright and other intellectual property laws. Customer acquires only the right to use Programs and does not 
acquire any rights, either express or implied, in Programs or media containing Programs other than those specified 
in this License. NXi shall at all times retain all rights, title and interest, including intellectual property rights, in 
Programs and media.  
The Service and any software it incorporates (”Software“) contain proprietary and confidential information that is 
protected by applicable intellectual property and other laws. Except as expressly authorized by us you will not 
modify, sell, or distribute works based on the Service or the Software. 
LICENSE: Your license to Programs is subject to the following restrictions:  
1. NXi reserves all rights not expressly granted to you.  
2. Customer may use the Programs solely for its own internal purposes.  
3. Customer shall not: (a) remove any product identification, copyright notices, or other notices or proprietary 
restrictions from Programs; (b) transfer, sell, assign or otherwise convey Programs to another party without NXi’s 
prior written consent; or (c) cause or permit reverse engineering, disassembly, or decompilation of Programs.  
LIMITED WARRANTIES/EXCLUSIVE REMEDIES: Your use of the Service or Programs to access the Service are 
limited to the following warranties. 
While we make every effort to provide the highest quality performance by the Service, we provide the Service on an 
”as is, as available“ basis.  You use it at your own risk, and NXi and its employees are not liable for any errors or 
omissions in communications transmitted by the Service, or for any form of loss or damage (including any 
consequential, indirect, incidental, special, or exemplary damages, even if known to us) that may result from its use.  
The Service is neither intended nor approved for communications with emergency services (911 calls, etc.), and  
NXi will accept no liability for errors or omissions in such calls.  No warranty not set forth in this agreement will be 
valid.  If any of the above provisions are void under governing law, our liability shall be limited to the extent permitted 
by law. 
NXi DOES NOT warrant that: Programs will meet Customer’s requirements, Programs will operate in combinations 
Customer may select for use, operation of Programs will be uninterrupted or error-free, or all Program errors will be 
corrected. These warranties are exclusive and in lieu of all other warranties, whether express or implied, including 
implied warranties of merchantability or fitness for a particular purpose. If Customer reports an error in a Programs 
within the 90 day period, NXi shall, at its option, correct the error, provide Customer with a reasonable procedure to 
circumvent the error, or, upon return of Programs to NXi by Customer, refund the license fees. NXi will replace any 
defective media without charge if it is returned to NXi within the 90 day period. These are Customer’s sole and 
exclusive remedies for any breach of warranty. This limited warranty gives you specific legal rights. You may have 
others, which vary from state to state.  
REGARDLESS OF WHETHER ANY REMEDY SET FORTH HEREIN FAILS OF ITS ESSENTIAL PURPOSE, IN 
NO EVENT SHALL NXi BE LIABLE FOR ANY INDIRECT, INCIDENTAL, SPECIAL OR CONSEQUENTIAL 
DAMAGES, OR DAMAGES FOR LOSS OF PROFITS, REVENUE, DATA OR DATA USE, INCURRED BY 
CUSTOMER OR ANY THIRD PARTY, WHETHER IN AN ACTION IN CONTRACT OR TORT, EVEN IF NXi HAS 
BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. Some states do not allow the limitation of liability for 
incidental or consequential damages so the above limitation may not apply to you. 
IN NO CASE SHALL NXi’s LIABILITY EXCEED THE PURCHASE PRICE FOR THE PROGRAMS. The disclaimers 
and limitations set forth shall apply regardless of whether you accept the Programs.  
 
NXI DISCRETION OVER CONTENT, USE AND OPERATION OF THE SERVICE: We are not liable for the deletion 
or loss of messages, other communications, or other content maintained or transmitted by the Service. We may 
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change or terminate the Service or any part of it without notice or liability. We may terminate or change your 
password, account, or use of all or any part of the Service without notice and for any reason, including 
Technical/development reasons and/or violation of these terms. 
  
YOUR RESPONSIBILITY FOR CONTENT & CONDUCT    
You are responsible for any content that you transmit through the Service.  NXi will not accept responsibility for 
content that: 

• is unlawful, harmful to minors, threatening, harassing, abusive, defamatory, vulgar, gratuitously violent, 
obscene, pornographic, libelous, invasive of another’s privacy, or racially, ethnically or otherwise 
offensive; 

• includes personally identifiable information about children;   
• infringes someone else’s intellectual property or other rights;   
• advocates or solicits violence or other criminal conduct; 
• violates any law, regulation, or contract;   
• promotes participation in multi-level or pyramid marketing initiatives;   
• constitutes a raffle, sweepstakes, lottery, or any other form of gambling;   
• specifically advertises any product or service that is illegal in Utah or the domicile of either the Distributor 

or Recipient; 
• constitutes unsolicited or unauthorized advertising, or any unsolicited commercial communication;   
• contains software viruses or any other computer code, files, or programs that are designed or intended to 

disrupt, damage, or limit the functioning of any software, hardware, or telecommunications equipment.   
                           
You will comply with all applicable laws and regulations regarding online conduct and content. You will not use the 
Service to collect, store, or use information about others for the purpose of sending unsolicited or unauthorized 
communications. Except as we specifically authorize (via license or otherwise), you will not reproduce, distribute, or 
commercially exploit any part of the Service.                      
  
ACCURATE INFORMATION: You will provide accurate and current information on all registration forms on the 
Service. You will not impersonate any person or entity, or misrepresent your affiliation with a person or entity.  
  
PRIVACY POLICY:  User information is requested for internal purposes only.  NXi considers all information supplied 
by users to be private and personal.   User information will not be published, released, or sold in any form to anyone 
except as required by law or in the good faith belief that doing so is necessary to: (a) comply with legal process; (b) 
enforce these terms, (c) protect the rights, property, or personal safety of NXi, its users, or the public, or (d) 
administer the Service.   
  
SECURITY / NO DISRUPTION:  You are responsible for all activities that occur under your password or account, 
and will keep your password(s) confidential.  You will immediately notify us of any unauthorized use of your 
password or account or any other breach of security. You will not disrupt the functioning of the Service, solicit 
another user’s password, or otherwise act in a way that interferes with other users' use of the Service. Nor may you 
transmit or distribute any computer program that damages, detrimentally interferes with, surreptitiously intercepts, or 
expropriates any system, data, or personal information.   
  
OBJECTIONABLE CONTENT:  The opinions and views expressed by other users of the Service do not necessarily 
reflect those of NXi. You waive any claim resulting from your exposure to material on the Service that is offensive, 
indecent, or otherwise objectionable. 
  
INDEMNITY:  You will indemnify NXi, and its affiliates, officers, agents, and employees against any claim or 
demand, including reasonable attorneys' fees, related to content you distribute via the Service or your use of or 
conduct on the Service. 
 
GENERAL TERMS 
This Agreement constitutes the entire agreement between you and NXi and governs your use of the Service. 
Interpretations of the Agreement and determinations that you have breached the Agreement will be made at our 
reasonable discretion and based on facts known to us. Our failure to enforce any right under this Agreement will not 
waive that right. If any provision of this Agreement is invalid, the Agreement should be interpreted to effect the intent 
of the parties, and the remaining provisions will remain in effect. You must file any claim or suit related to the 
Service within one year after it arises. The section titles in this Agreement are for convenience only and have no 
substantive effect.   
 
GOVERNING LAW. Except as otherwise restricted by law, this License shall be governed by, and interpreted in 
accordance with, the laws of the State of Utah of the United States of America, without regard to laws of Utah 
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governing conflict of laws. Furthermore, it is understood that this License shall be treated as though it were executed 
in Salt Lake County of the State of Utah. The parties agree that any action relating to this License shall be instituted 
and prosecuted in the courts of competent jurisdiction of the State of Utah. You agree to submit to the personal and 
exclusive jurisdiction of the state and federal courts located in Utah for any claim or dispute with NXi or any of its 
affiliates, officers, agents, or employees. 
 
U.S. GOVERNMENT RESTRICTED RIGHTS. The Software and documentation are provided as ”Commercial 
Computer Software“ or ”restricted computer software“. They are delivered and licensed as ”commercial computer 
software“ as defined in DFARS 252.227-7013 (Oct 1988), DFARS 252.211-7015 (May 1991) or DFARS 252.227-
7014 (Jun 1995), or as ”Restricted computer software“ as defined in FAR 52.227-19 (Jun 1987) (or any equivalent 
agency regulation or contract clause), whichever is applicable. You have only those rights provided for such 
Software and Documentation by the applicable FAR or DFARS clause or the NXi standard software agreement for 
the product. 
 
ENTIRE LICENSE. This License sets forth the entire understanding and License between you and NXi and may be 
amended only in a writing signed by both parties. NO VENDOR, DISTRIBUTOR, DEALER, RETAILER, SALES 
PERSON OR OTHER PERSON IS AUTHORIZED TO MODIFY THIS LICENSE OR TO MAKE ANY 
REPRESENTATION OR PROMISE WHICH IS DIFFERENT THAN, OR IN ADDITION TO, THE 
REPRESENTATIONS OR PROMISES OF THIS LICENSE.  
 
WAIVER. No waiver of any right under this License shall be effective unless in writing, signed by a duly authorized 
representative of the party to be bound. No waiver of any past or present right arising from any breach or failure to 
perform shall be deemed to be a waiver of any future right arising under this License.  
 
SEVERABILITY. If any provision in this License is invalid or unenforceable, that provision shall be construed, 
limited, modified or, if necessary, severed, to the extent necessary, to eliminate its invalidity or unenforceability, and 
the other provisions of this License shall remain unaffected. 
 
NOTICES. 
Notices to you may be made via email, telephone, or by changes to this Agreement. 
NexCom, NexTalk, NXi Text Services, NexTalk for Networks, NexTalk-VM, NexTalk.net and Soft-TTY are registered 
trademarks, trademarks or service marks owned by NXi Communications, Inc.  All other registered trademarks, 
trademarks or service marks are used herein for reference purposes only and remain the property of their respective 
owners. 
NXi Communications, Inc. 
4505 S. Wasatch Blvd., Suite 120 
Salt Lake City, UT  84124 
voice: 801-274-6001 
TTY: 801-274-6004 
fax: 801-274-6002 
internet: www.nextalk.com 
 
(c) Copyright NXi Communications, Inc. 2002. All rights reserved. 
 
Last Modified - 7/17/2001 
 

NTS' NexTalk users: 
See License Agreement in the NTS System Administrator’s Manual, or contact NXi for a copy of this license 
agreement. 
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Index 

—A— 
Accessibility Menu, 11 
Alerts Menu, 10 
Alerts, conversation, 10, 24 
Alphabetizing phonebook entries, 18 
Answer Greeting, 23 
Answer Settings, 25 
Answering a call 

Answer button, 7 
Audible alert, 7 
auto-start, 22 

—C— 
Call Transfers, 20 
Carrying on a Text (TTY) Conversation 

conventions, 7 
Changing your password, 22 
Color scheme, conversations, 23 
Conference Calls, 19 
Conversation Alerts, 24 
Conversation Font/Colors, 23 
Conversation View Modes 

terminal mode, 15 
vertical split-screen mode, 15 

Conversation Window, options, 9 
Conversations 

saving, 13 

—D— 
Department precomposed text, 11 
Dialing settings, 25 

—E— 
E-mail, set forwarding options, 22 

—F— 
Font type/size, conversations, 23 
Forwarding, message, 23 
Full Screen, 15 

—G— 
Garbled Text, Unscrambling, 10 
Greetings, 22 

—H— 
Horizontal Split-screen, 16 
Hot keys, setting, 25 

—I— 
icon-only view, 22 
Instant Message Font/Colors, 24 
Instant Message, send via phonebook, 19 
Instant Messages, 14 

—J— 
JAWS screen readers 

support for, 5 

—L— 
License Agreement, 27 
Log in as department, 11 
Login name, 21 
Login Procedures, 21 

—M— 
Mailbox messages, 11 
Making a Call, 8 
Message Forwarding, 22 
Message routing, 12 
Message taking, 22 
Messages 

saving, 11 
sending, 14 
viewing, 11 

Minimize to taskbar, 22 
Modem Access, 25 
Modem Settings, 25 
Multiple Conversations, 20 

—N— 
Network calls, 8 
New message indicator, 12 
NexTalk Address, 18 
NexTalk.net service, overview, 5 
NTS login, 21 

—O— 
Outside (modem) call, 8 

—P— 
Pager, 22 
Password, 22 
Phone Books, 17 
Play sound, 23 
Precomposed Text, 25 
precomposed text, shared, 11 
Preferences 
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modem, 25 
Preferences, setting, 22 
Printing Font, 23 
Product Overview 

product description, 5 
Programs License Agreement, 27 

—Q— 
Quick Call, 8 

—R— 
Receiving a Call, 7 
Relay Operator:, 25 
Reply, to Instant Message, 15 
Retrieving & Routing Messages, 11 
Ring alert, 23 

—S— 
Sending Messages, 14 
Shared text, 11 
Split screen, vertical, 16 
Split-screen, horizontal, 16 
Startup & Shutdown Settings, 22 
Support, 26 
Switched case, 10 

—T— 
Tech Support, 26 

Terms of Service, 27 
Text mailbox, 11 
Text Menu, 11 
Toolbar, 6 
Transferring a call, 20 
TTY calling options, 25 
TTY conversations 

conventions, 7 
TTY view mode, 16 

—U— 
Unscramble TTY, 10 
User Name, 22 
Using the Toolbar, 6 
Using your NexTalk Phone Book, 17 

—V— 
Vertical Split-screen, 15 
View mode, TTY, 16 
Viewer, 13 
Viewing Saved Conversations, 13 
Views 

conversation, 15 

—W— 
Web page, NXi, 26 
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